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CHAPTER 1 

IMail Utilities 

In This Chapter 
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To access all utilities go to Start > Ipswitch IMail Server > Utilities. This will display all 
available utilities to run. 

The default location for all selected IMail Utilities is under "../IMail/Utilities" 
directory. 

Utility System Requirements 
 Microsoft® .NET Framework 3.5 Service Pack 1 - Windows Update 

http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=ab993
42f-5d1a-413d-8319-81da479ab0d7 
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CHAPTER 2 

Collaboration Duplicate Entry Remover 

The Collaboration Duplicate Entry Remover utility will search for duplicate entries within the 
IMail Server's Collaboration database. 

Duplicate entry options 

 Appointments - Appointments or events  

 Contacts 

 Tasks 

 Notes 

 Mail Messages 

The Collaboration Duplicate Entry Remover utility has 3 steps: 

1 Select the table (shown above) to search. 
2 Click Find Duplicates button. Processing may take longer depending on the size of the 

Collaboration database. 
3 Click Remove Duplicates button. Processing the deletion of duplicates may take longer 

depending on the size of the Collaboration database. 

 
 



 
 

CHAPTER 3 

Disk Space Usage Reporter 

The Disk Space Usage Reporter is a command level utility that requires no user interface. 
This utility can be accessed and located at Start > All Programs > Ipswitch > IMail Server 
Utilities > Disk Space Usage Reporter.   

Selection will open explorer to the location of the Disk Space Usage Reporter folder. Double 
click the "Disk Space Usage Report.exe" to execute and generate the following: 

 Report.csv. A comma delimited .CSV file generated from the Report.html data. 

 Report.html. This html page will display individual mailbox sizes (MB). 

 Domain. Sorted by domain and totaling all space for the domain. 

 UserID. Sorted by UserID within domain and totaling all space for each UserID. 

 Mailbox. Sorted by Mailbox within the UserID, and totaling space for each mailbox. 

 Note: The files generated will automatically be saved to the same path location as the Disk 
Space Usage Reporter executeable. 
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CHAPTER 4 

Forward Finder 

The Forward Finder Utility gives the IMail Administrator control over what IMail User's are 
placing in their Forwarding Address. This utility will display users that have set their e-mail to 
forward to another address, and will also allow these forward addresses to be removed. 

 Domain. Set to All Domains by default. The drop down will display all available 
domains within the IMail Server. 

 Search. Searching with no text will display all users that have entered an alternate 
Forwarding Address. The search feature targets the Forwarding Address field. For 
Example:  Entering "aol" will display all users that have updated their Forwarding 
Address to a personal AOL account.  

 Select All. Clicking "Select All" will check all addresses displayed. 

 Mail Address. Email Address of associated user with a Forwarding Address. 

 Forwarding Address. By default this text box is blank. Entering an e-mail address will 
forward all incoming e-mail to the new address. 

Edit Selected. Clicking this will update all selected user's Forwarding Address. 

Remove Selected. Clicking this will remove any address entered in the Forwarding Address.  

Export. Click this button to export the search results to a comma delimited .csv file. 

 

 
 



 
 

CHAPTER 5 

IMAP Copy Utility 

In This Chapter 

About IMAP Copy Utility ..................................................................................... 5 

IMAP Copier Details .............................................................................................. 5 

Troubleshooting .................................................................................................... 8 

Known Issues ........................................................................................................... 9 
 
 

About IMAP Copy Utility 
The "IMail IMAP Copier.exe" is a utility for copying mailbox messages from one mail server 
to another IMail Server using IMAP.  

Requirements: 
 Source Mail Server. Domain name or IP address of a Mail Server to be copied from. 

 Destination IMail Server. Domain name or IP address of an IMail Server v10.02 or 
higher. 

 CSV (Comma Separated Value) text file. Containing User names and passwords for 
authenticating on source and destination servers. 

 ignore.txt. Contains folder names that will be ignored and not copied. (e.g. Deleted, 
Sent, SPAM) The "ignore.txt" file must be in the same path as the "IMail IMAP 
Copier.exe".  

 

 
 

IMAP Copier Details 

 Tip: Be sure IMAP is running on both Mail Servers 
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IMail Utilities Help 

 

 Source IMAP Server. Requires a Domain Name or IP Address of the Mail Server that 
will be copied from. This Mail Server can be from a multitude of server types. (e.g. 
IMail, SmarterMail, Merick, MDaemon) 

 Note: For Exchange Servers it is recommended that the Migration Utility be used, contact 
Technical Support for detail information. 

 Port. Determines port number to access with the Source Mail Server. 

 Destination IMail IMAP Server. Requires the Domain N ame or IP Address of an 
installed IMail Server v10.02 or later. 

 Port. Determines port number to access with the Destination IMail Server. 

 Authentication Method. (Default is Login) 

 Login  

 CRAM-MD5 

 Plain  

 Note: Both Mail Servers must support the same authentication settings 

 # of Threads. (Default is 25) Controls the maximum number of threads allowed 
during runtime. This value can be adjusted during runtime. Valid thread counts are 1 
through 100. 
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IMail Utilities Help 

 Caution:  Raising thread usage causes a higher load on the IMAP Service and Disk I/O, 
which will slow down the overall process. 

 CSV (Comma Separated Value) User File. Click the  button to browse and select 
the correct path. The format of the CSV text file must be correct to function correctly 
for authenticating on source and destination servers. 

Note: Sample format of this file is as follows:  

User Name User Password 
user1, test 

user2, test 

user3, test 

 

Copying Options (Default is IMAP Append Command preserving the message dates) 

 Direct Write to Mailbox. This option will allow the utility to write directly to the users' 
mailbox and will not use IMAP.  

 IMail Host Name. This is a required field when using Direct Write to Mailbox. 

 IMAP Append Command. Uses the IMAP Append Command to add messages from 
the Source Mail Server to the Destination IMail Server. 

 Preserve Message Dates. This check box will maintain the correct dates for the 
mail messages. Not checking this box will use the current Date and Time for all 
messages copied. 

 Warning: Destination IMail Servers with v10.01 or earlier, does not have capability to use 
Preserve Message Dates, and requires this check box to be unchecked to work properly. 

Retry Settings 

 Retry on Failed Commands. (Set by default) Functionality for controlling the amount 
of retries before a command failure is issued. When turned off a command failure will 
stop the utility, without retrying. 

 Retry Count. (Default is 20) The number of retries before command failure stops the 
utility. 

 Retry Delay (Seconds). (Default is 60) Number of seconds between each retry. 

Data Information  
 Log. Will display log messages of the IMAP Copy Utility as it progresses. 

 Active Users. Will display the current user that is being processed. 
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IMail Utilities Help 

Troubleshooting 
Possible issues with the IMail IMAP Copier: 

=================================================== 

Issue:  Error Message "Destination server is not IMail / Unable to connect - aborting" 

Solution: Your destination Mail Server must be an IMail Server, if this case is true, please 
contact Technical Support for support to correct this issue. 

=================================================== 

Issue:  Error Message "Unable to find user file" 

Solution:  Be sure that the path to your CSV User File is correct. 

=================================================== 

Issue: Log Message: 16:09:32: Err: dude - Error(s) occurred while copying this users mail 

Solution: All User Names must be valid users in both Mail Servers. "AddUser.exe" utility can 
be used to manually add users. Refer to your online Administration Help under "Command 
Line Utilities" for more details. 

=================================================== 

Issue: Log Message: 08:03:26: Err: <none> - Unable to parse line from csv file - admin test 

Solution: Your CSV User File is incorrectly formatted. Be each user is formatted as follows: 

Correct format is: 

username1, password 

username2, password 

=================================================== 

Issue: Log Message: 10:57:24: Err: admin - Unable to connect to Server 192.168.5.155 
System.Exception: AUTHENTICATE Invalid userid/password 

Solution: CSV User File contains the wrong password for specified user. 

=================================================== 

Issue: Log Message: 08:15:26: Err: dude - Unable to connect to Server 192.168.3.179 
Hunny.Mail.Exception: Connection refused 

Solution: Check that IMAP service is started on both Mail Servers. 

=================================================== 
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Issue: Log Message: 11:25:15: Error: dude - Error selecting folder Quotes EXAMINE Not 
Subscribed Quotes 

Solution: Check your IMAP settings and be sure that Force Subscribe to Public & Private 
Mailboxes are not checked. 

=================================================== 
 

Known Issues 

Known issues with the IMail IMAP Copier: 
=================================================== 

 Clients using POP and leaving on the server will cause all messages to download 
again as "new". 

 Clients using IMAP will notice all messages being downloaded again, but all message 
flags will be preserved. 

 IMAP and IMail Web Messaging will not show the correct message date if destination 
IMail Server is not v10.02 or later. 

 User Names and Passwords need to be identical for both Mail Servers. 

 Authentication Method on both Mail Servers need to be identical. 

 

 

 

 

 

 
 



 
 

CHAPTER 6 

IMail Collaboration Database Converter 

The IMail Collaboration Database Converter Utility will convert your IMail Collaboration 
database which contains all contact information from Microsoft Access (.mdb) to a local 
Microsoft SQL Server.  

 Important: After completion of conversion, rerun the IMail Server installation using 
"modify". This will allow the MSI Installer to recognize the modified System DSN.  

Utility Function 

 A WorkgroupShare database will be created in the local Microsoft SQL server if it does 
not already exist. 

 All data will be copied from the Access tables in the "WorkgroupShare.mdb" 
database into the SQL Server database.  

 The ODBC system DSN set for the IMail Collaboration database, will modify the 
DBType registry key to reflect usage of a SQL server. 

Utility Steps 
1 Stop the following services to avoid data corruption. 

 WorkgroupShare Service 
 World Wide Web Service 

2 Select the Access Database to Import from. This database by default is located  
"…Ipswitch\IMail\WorkgroupShare\Data\WorkgroupShare.mdb"  

3 Select the SQL Server to Import to. Drop down displays all available SQL Servers.  

 Note: This may take some time as it searches for all SQL Server's on the local machine or the 
network. 

4 Select one of the locations for the SQL data files. 
 Default SQL Server data path  
 Default IMail Collaboration data path "…\IMail\WorkgroupShare\Data" 
 Your choice, use the folder browser to select the location 

5 Import Data to SQL.  This step performs all of the procedures from creating the 
database, creating the tables and setting user permissions, to finally importing the data 
to the SQL server. 

6 Finish the Migration to SQL.  This final step will create the System DSN and set the 
registry key. 

7 Rerun the IMail Server installation using "modify". This will allow the MSI Installer to 
recognize the modified System DSN. 

 Note: All steps are appended to a log file located in the same directory as the utility. 
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CHAPTER 7 

Import Export Utility 

In This Chapter 

Export Domain ..................................................................................................... 11 

Import Domain .................................................................................................... 12 

Convert Domain Database Format .............................................................. 13 

User Import Export Utility has multiple functions for the IMail Server installed: 

 Export One or More Domains (on page 11). Will export the domain properties and 
users for one or more IMail domains. 

 Import One or More Domains (on page 12). This will import the domain properties 
and users for one or more IMail domains. 

 Convert a Domains Database Format (on page 13). This will convert an IMail 
domain database to an External database. 

 
 

Export Domain 
Export One or More Domains. This selection will export the domain properties and users for 
one or more IMail Server domains. 

 Select Domain To Export. The drop down will display a list of all domains that 
currently exist on the IMail Server. 

 Tip: Selecting the "All Domains" option will save each domain "export.csv" file and place it 
under the generated "../IMail/DomainName" directory. 

 File To Export To. The default path is "../IMail/DomainName/export.csv". 

 Export User Data. Click this check box to also export user properties. 

 Full Name. 

 Email Address. 

 Password. 

 Path to User Directory. 

 Forward address(es). Will be semicolon delimited. 

 Note: A log file is generated for all exports with the path displayed at the end of the export 
page. 
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IMail Utilities Help 

 
 

Import Domain 
Import One or More Domains. This selection will import the domain properties and users for 
one or more IMail domains. 

Select Import Options 

 File. Import domain properties and user properties into your IMail Server. 

 Import Domain From File. Enter the path for the exported CSV file. 

 Tip: This selection is only for importing to a new domain and the domain properties. It will 
not run if the domain name already exists on the IMail Server. 

 Import to Domain. This selection is for selecting the domain to import the exported 
user CSV file. 

 Path to User's File. Enter the path for the exported user CSV file. 

 Tip: Its possible to Import both a new Domain file and User file at one time. See Examples (on 
page 12). 

 AD/NT. Import users from AD or NT database. This will import AD/NT users into your 
IMail Server. 

 Import to. Select the IMail domain name that all AD/NT users will be imported to. 

 Default password. Enter the password that will be assigned to all the new users 
created. 

 Select the following user options for the new users being created. 

 Allow Web Access 

 Allow Password Change 

 Allow Web Calendaring 

 Visible to LDAP 
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IMail Utilities Help 

Import Export Examples 
Example 1: 

IMail Administrator wants to transfer domain1.com and all the users from an old IMail 
Server to a new IMail Server.  

1 Run the ImportExport utility on the old IMail Server to export the domain, and also 
check the user data checkbox to generate both an "Export.csv" and "Users.csv" 
file. 

2 These files will be saved under the "../IMail/domain1.com" directory. 
3 Copy these files to the new IMail Server. 
4 Run the ImportExport utility on the new IMail Server. 
5 Select Import > File > Import Domain From File and browse to locate the path for the 

"Export.csv". 
6 Select Path to User's File and browse to locate the path for the "Users.csv". 
7 Click Import. This will create "domain1.com" with original properties, and add all 

user's. 

Example 2: 

IMail Administrator has wants to transfer users from domain1.com to domain2.com on the 
IMail Server. 

1 Run the ImportExport utility to Export and select domain1.com. 
2 Check the user data checkbox to generate the "Users.csv" file. 
3 This file will save to "../IMail/domain1.com" directory. 
4 Run the ImportExport utility again to Import to domain2.com on the IMail Server. 
5 Select Import > File > Import To Domain and select domain2.com. 
6 Select Path to User's File and browse to locate the path for the "Users.csv" located 

at the "..IMail/domain1.com". 
7 Click Import. This will add users to domain1.com. 
8 Keep in the mind the new transferred users Reply To Address will still be set to the 

domain1.com. To correct this go to User Administration > User Utilities > Set Default 
Reply To and select "domain2.com" from the domain dropdown if it is not already 
selected. 

9 Enter "domain2.com" to reset all users for the selected domain. 
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IMail Utilities Help 

Convert Domain Database Format 
Convert a Domains Database Format. This selection will  convert two ways: 

1 An IMail user database to an External user database. 
2 An External user database to an IMail user database. 

 Important: Before using an external database for a user domain in IMail, a System DSN must 
be created to point to a valid database name. See Creating a User Database (on page 14). 

Steps to Convert an External User Database 
1 Select the Domain to Convert. Displays all available IMail domains. 
2 Select the New Database Type. Select External Database. 
3 Path to ODBC DLL. The path to the "odbcuser.dll" is located under ../IMail directory. 
4 System DSN. Enter the ODBC System DSN assigned. 
5 Use SQL. Checkbox only when using SQL as external database. 

 SQL Username. Logon ID for SQL table access. 

 SQL Password.  

 Alternate Table Name. Optional. Leaving blank will default to the Domain Name as 
the table. 

 Note: If a SQL Table Name already exists for the domain being converted it will merge the 
existing IMail Users with the SQL table. 

Steps to Convert an IMail User Database 
1 Select the Domain to Convert. Displays all available IMail domains. 
2 Select the New Database Type. Select IMail Database. 
3 Click Convert and the database will begin converting. 

 Note: If the IMail registry for user already exists for the domain being converted it will merge 
the existing users with the new users. 

 Note: Depending on the size of the user database, this process may take longer. 

 
 

Creating External User Database for a Mail Domain 
IMail Server can use an external database to register and authenticate users on a particular 
mail domain. Users that you add to and delete from an IMail Server host are also added to 
and deleted from the external database. 
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IMail Utilities Help 

 Important: Remember to restart the IMail Services, after creating external database. 

Before you use an external database for a mail domain, use the Windows Control Panel to 
make sure there is a System DSN (Data Source Name) that points to a valid database name. 
See your Windows and database documentation for information on the System DSN. 

 Important: When you configure a DSN to an SQL data source in the Microsoft Windows 
ODBC Data Source Administrator, it may default to Named Pipes network library. Make sure 
that you set the connection type to TCP/IP in order for the external database to work 
correctly. 

After you have verified the System DSN that points to the database you want to use, you can 
configure an external database. 

 Note: The external database can reside locally with the IMail Server. 

Configuring an External User Database 
The connection between IMail Server and an external user database is accomplished via a 
dynamic link library (DLL file). IMail Server includes a sample .dll file (ODBCUSER.DLL). This 
DLL uses the ODBC method, but can be modified to support other external database 
methods. The complete source code for this DLL is provided upon request from Ipswitch. 

When you configure an external user database, IMail Server creates an ODBC database that 
holds tables configured with the correct fields. The fields are identified in the Table Name 
text box. After the database is created and the ODBC system data source name is established 
in the ODBC Source Administration tool (located in the Windows Control Panel), you can use 
the database to store user authentication information and user properties. This information 
can be managed through IMail Administrator, including adding and deleting users. 

 Important: When using an external database, any IMail service you run (except the Log 
Server) must be set up from the Windows Control Panel Services application so the account 
that IMail Server runs under has access to the external database. 

To create a mail domain that uses an external database: 
1 In IMail Administrator, click Domain > Domain Properties. 
2 In the User Database section, select External Database from the User Database type 

list box. 
3 Click the Configure button. A domain options page appears. 

 External Database Implementation DLL. Enter the full path to the odbcuser.dll 
installed on your local server or the path of a .DLL that supports the functions: 
GetUserEntry, SetUserEntry, DeleteUserEntry, AuthorizeUser, GetFirstUserEntry, and 
GetNextUserEntry. (These are defined in the odbcuser.h file.) 
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 ODBC System Data Source Name (DSN). Enter the source name for the database 
where the user information is stored. IMAILSECDB is the default name that the ODBC 
link uses. 

 Important: For users using SQL 7.0 or above, enter the following information after the ODBC 
System Data Source Name box: DSN_NAME;UID=<username>;PWD=<password>. The user 
name and password need to be the User ID and password for the SQL database and not an 
IMail Server account. 

 Table Name. Enter the table name within your ODBC database. Leaving "[default]" in 
this text box will use your domain name as the table name. All periods will be 
replaced with underscores.  

 Important: The table name cannot begin with a number. 

Example:  
If you use the Data Source Name IMAILSECDB and the username AUGUSTA and password 
GEORGIA, the correct format of the ODBC System Data Source Name box is: 
IMAILSECDB;UID=AUGUSTA;PWD=GEORGIA 

 Table name. Enter the database table name. If the field is blank or contains [default], 
the host name is used with dots replaced by underscores. The Table name cannot 
begin with a number. 

 Enable Multiple Connections to allow multiple connections from the external 
database to IMail Server. 

 Maximum Number of Connections to set the maximum number of connections 
from the external database to IMail Server. 

Save. Click this button to save your settings. 

Cancel. Click Cancel to exit without saving changes. 
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CHAPTER 8 

ISMail Migration 

ISMail Migration Utility will migrate all domains and users from the ISMail (a mail server) 
registry keys and import them into the IMail Server. 

 Note: ISMail and IMail must both be located on the same computer 
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CHAPTER 9 

Last Login Reporter 

The Last Login Reporter will report all users that have not logged in since the specified user 
interface criteria.  

 Domain. Set to "Any" by default. The drop down will display all available domains 
within the IMail Server. 

 Days since last login. Set to 90 by default. This setting is the number of days that will 
be used to report users that have not "logged in". 

 Search. Click "Search" to begin processing for the Last Login Report using the 
selected criteria. 

 Ignore System Administrators. Checked by default. The Last Login Report will not 
report any users that are System Administrators. 

 Ignore Host Administrators. Checked by default. The Last Login Report will not 
report any users that are Domain Administrators. 

 Ignore List Administrators. Checked by default. The Last Login Report will not 
report any users that are List Administrators. 

Last Login Report 
 User. User name associated with selected criteria. 

 Last Login Date. Date of user's last login.  

 System Admin. (True/False) Designates whether user is a System Administrator. 

 Host Admin. (True/False) Designates whether user is a Domain Administrator. 

 List Admin. (True/False) Designates whether user is a List Administrator. 

Save. Click this to save and generate a comma delimited .CSV file for importing. 

Delete Selected. Clicking this will delete only the selected user(s).  

Delete All. Clicking this will permanently delete all users displayed in the Last Login Report. 

 

 
 



 
 

CHAPTER 10 

Log Reader 

The Log Reader utility will display the IMail SMTP logs in a more user friendly format. The Log 
Reader also has many selection options to narrow down the logs to be displayed. 

 Tip: After completing a general search, double clicking on a Session ID or Thread ID will 
open another page to display actual log lines of the specified ID. 

 Choose a Log File. By default the utility will search and display the SMTP log files by 
accessing the path displayed in the following registry key: 

HKEY_LOCAL_MACHINE > Software > Ipswitch > IMail > Global > SpoolDir 

 Browse. Click the Browse button to search an alternate path. 

 Search Options 

 Search Type. Click this drop down to select the option needed to refine the search 
needed. 

 General. Performs a full search with no specific options. 

 Thread ID. (Sometimes also called Message ID) A valid Thread ID is 16 characters 
long. The search will return empty if the Thread ID is invalid. 

 Session ID. A valid Session ID is 8 characters long, or the middle 8 characters of 
the Thread ID. 

 Limit Results. (Only valid with the General search option) Click this checkbox to limit 
the number of log lines to display. 

 Search Text. Leaving this blank will display all log lines. 

 Search. Click Search to begin processing. 

 RegEx. Click this checkbox to use a regular expression 

 Export to File. Click this button to export the search results to a CSV file. 

 Tip: Using spreadsheet it is recommended to import the file to correctly display all columns 
correctly. 
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CHAPTER 11 

Mailbox Reporter 

The Mailbox Reporter will display message information on a specific mailbox, and will also 
save as a CSV file for further reporting. 

MBX Information 

Date. Date of message. 

Messages. Total message count for specified date. 

Size. Total size of all message for specified date. 

 
 



 
 

CHAPTER 12 

User Flags Updater 

The User Flags Updater utility will update two specific settings on the IMail Server system 
wide: 

 User Preference > Allow Web Calendar setting. On / Off. 

 Hide All. Will turn off Web Calendar for all users on the IMail Server. 

 Show For All. Will turn on Web Calendar for all users on the IMail Server. 

 Web Client > Default Setting for new Messages. HTML / Plain Text. 

 Enable for all. Will enable HTML as the default setting for new messages. 

 Disable for all. Will enable Plain Text as the default setting for new message. 

 Important: These setting changes will update all users on all domains on your IMail Server 
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CHAPTER 13 

User Password Strength Checker 

The User Password Strength Utility is designed to identify users with passwords that are 
not in compliance with the domain password strength setting. This utility will report all users 
with a Pass/Fail sorted by domain. 

 Domain. Set to "Any Domain" by default. The drop down will display all available 
domains within the IMail Server. 

 Display. Click "Display" to begin processing for the User Password Strength Report 
using the selected domain. 

User Password Audit Report 
 User. Email Address of associated user with a Forwarding Address. 

 Password Audit. Pass/Fail. Passing meets the domain level password strength 
setting. Failing does not meet the domain level password strength setting.  

 Note: To view the password strength setting go to the Web Administrator or Console 
Administrator Domain Properties > User Login Options > Required Password Strength. 
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